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#UCET16 is Coming  
by Derek Larson

We are so excited to announce the 2016 
UCET Conference dates and location! 
You may have had a sneak peak on 
Twitter recently, but if not, get ready 
because #UCET16 is coming to the 
University of Utah on March 17-18, 2016 
with our theme of Tech Madness!

We will have lots more information in 
the coming days, but we do know who 
our awesome keynotes will be and are 
so excited to introduce them to you, 
Thurl Bailey (@bigTbailey) and Ginger 
Lewman (@GingerLewman)!

Thurl is a Utah Jazz Pregame, Halftime, 
and Postgame Analyst who is also very 
talented with singing and songwriting. 
He’s an inspirational speaker and a Dad!

Ginger is a PBL (Project/Problem Based 
Learning) and GT (Gifted & Talented) 
consultant. She is a SiloKiller, the creator 

of #STEAMmaker and a co-creator of 
LifePractice PBL. Ginger is a Google 
Certified Innovator. As a teacher, she’s a 
resource and not THE source. 

We are super excited because you are 
gonna LOVE them! If you want to learn 
more about our Keynotes, head over to 
our Keynotes page and check out links 
to their websites.

For more information on #UCET16, 
check out our Conference page where 
you can start to find all of the pertinent 
information soon. Registration isn’t yet 
open for #UCET216, but we wanted you 
to be aware of the location and dates so 
you can reserve your substitute teachers 
and get ready for some Tech Madness!

Keep watching the UCET blog, the 
official UCET Twitter account, and our 
UCET Facebook page for more details. 
We hope to see you at the University of 
Utah on March 17-18. 2016!

http://www.ucet.org
http://www.ucet.org/blog/
https://twitter.com/ucet
https://www.facebook.com/ucetorg


Come Serve with Us
by Michael Hakkarinen

The UCET President Elect position 
and four elected board member 
positions will need to be filled this 
year due to term limitations. To fill 
these positions, elections will be 
conducted on Friday, March 18, 2016, 
from 7:30 a.m. to 2:30 p.m. 

Information about how to access the 
ballot will be sent via email to each 
UCET member.  

The election results will be 
announced in the closing session 
of the UCET conference on Friday, 
March 18, 2016. Results will also be 
sent to UCET members via email and 
will be posted to the web site.

To find out more about what the 
UCET board does, visit About and 
Board. 

All candidates should complete 
the Google Form – https://goo.gl/
mrkUfb which includes a short bio 
and answer to the question, “I would 
like to serve on the UCET board 
because….” Submission deadline is 
Thursday, February 11, 2016.

#ucet16 Award Nominations Open 
by Pam Turley

Nominations for all UCET awards are now open and close on Thursday, February 
11, 2016.  All award winners will be announced Thursday, March 17, at the opening 
session of the 2016 UCET Conference.   

UCET Awards
UCET Outstanding Teacher of the Year – This award recognizes and honors 
a teacher who has demonstrated outstanding achievement and leadership in 
implementing technology to improve education. (PK-12 classroom teacher). 

UCET Outstanding Leader of the Year – This award recognizes and honors a leader 
who has demonstrated outstanding achievement and leadership in implementing 
technology to improve education. Nominee can be a principal, superintendent, school 
or district technology staff, regional technology trainer, etc. The one stipulation is that 
the nominee is not a PK-12 classroom teacher. They may have a teaching certificate, 
however their current position is not as a classroom teacher.

UCET Outstanding Young Educator of the Year – This award will be presented 
to an outstanding young educator (under the age of 35) who demonstrates vision, 
innovation, action, and transformation using technology to improve teaching and 
learning.

ISTE Award
Making IT Happen Award – Making IT Happen is an internationally recognized 
awards program administered by the International Society for Technology in 
Education (ISTE). This program honors educational technology educators and leaders 
for their commitment and innovation. ISTE sponsors the award, the jacket, and a 
press release about the award recipient. UCET sponsors a $500 cash award for the 
Making IT Happen recipient. Read more about this award here: http://www.iste.
org/lead/awards/making-it-happen-award.  

UCET must submit the Making IT Happen Award winner’s name and other 
information to ISTE well in advance to ensure that the Making IT Happen Award 
winner receives the coveted black (for men) or pink (for ladies) jacket.

Submission Form for all awards 

Free Interactive Education Webinar: Uncovering 
Greenland
Your planet is changing, and NASA is on it! During the 
summer of 2015, scientists embarked upon Greenland to 
research the hydrology of the ice sheet — studying the shifting 
network of streams and rivers that form during the melt 
season and transport water from the surface of the ice to the 
ocean, contributing to sea-level rise. Join NASA’s Goddard 
Space Flight Center for “Uncovering Greenland,” an hourlong 
webinar on Nov. 18, 2015, at 1 p.m. EST. During the live event, 
scientists and other experts will interact with students and 
teachers and dive into the discoveries made on this expedition.

If you would like to be placed on the “we’re interested” list, 
please email Erin McKinley at erin.e.mckinley@nasa.gov with 
the subject line “GREENLAND” no later than close of business 
on Nov. 4, 2015. In the email, please include the following 
information:

• 1. Your name
• 2. Your email address
• 3. Your telephone number
• 4. Your school’s name
• 5. Your school’s city
• 6. Your school’s state
• 7. Student grade levels
• 8. Anticipated number of students participating

There are a limited number of available slots for this live event, 
so participants will be selected through a random drawing. 
Schools not selected as an active participant will be sent 
information on the webcast. NOTE: Webcast participants will 
be able to interact live with the on-air guests by submitting 
questions via email.

http://www.ucet.org/about-us/
http://www.ucet.org/board/
https://goo.gl/mrkUfb
https://goo.gl/mrkUfb
http://www.iste.org/lead/awards/making-it-happen-award
http://www.iste.org/lead/awards/making-it-happen-award
https://goo.gl/cFa09P
mailto:erin.e.mckinley%40nasa.gov?subject=Uncovering%20Greenland%20Webinar


Free NASA Educator Professional Development Webinars
The NASA STEM Educator Professional Development Collaborative at 
Texas State University is presenting a series of free webinars open to all 
educators. Join NASA education specialists to learn about activities, lesson 
plans, educator guides and resources that bring NASA into your classroom. 
Registration is required to participate. Simply click on the link provided 
beneath the webinar description to register.

Forces and Motion of Flight: Fly by Math — Smart Skies 
Audience: Pre-service, In-service, Home School & Informal Educators of 
Grades 5-9 
Event Date: Nov. 9, 2015, at 6:30 p.m. EST

This webinar focuses on mathematics activities that allow students to 
explore and apply decision-making and proportional reasoning skills 
to resolve distance-rate-time problems in realistic air traffic control 
situations. A Web-based interactive Air Traffic Control Simulator that 
represents an air traffic controller’s screen will be used for solving 
problems. Register online to participate. https://www.etouches.
com/144035

Forces and Motion of Flight: Robotics in the Classroom, in the Air and in Space! 
Audience: Pre-service, In-service, Home School & Informal Educators of 
Grades 5-8 
Event Date: Nov. 10, 2015, at 6:30 p.m. EST

Discover the many ways in which you can bring the excitement of 
robotics to your students, using everyday, inexpensive materials. 
Engineering Design Challenges help develop robust thinking skills in 
your students. Register online to participate. https://www.etouches.
com/137335

Forces and Motion of Flight: Rocketry 101 
Audience: Pre-service, In-service, Home School & Informal Educators of 
Grades 4-8 
Event Date: Nov. 11, 2015, at 6 p.m. EST

Launch your students’ interest and excitement in forces and motion. 
Explore forces, motion and flight with fun, exciting rocket activities that 
include designing, building and launching simple rockets while students 
record, analyze and graph data. This webinar also will investigate rockets 
by integrating NASA missions, STEM curriculum, online education 
resources and the Next Generation Science Standards into teaching 
strategies that will help guide educators into a learning journey “blast-
off.” Register online to participate. https://www.etouches.com/146813

Forces and Motion of Flight: Breaking Barriers 
Audience: Pre-service, In-service, Home School & Informal Educators of 
Grades 5-8 
Event Date: Nov. 12, 2015, at 6:30 p.m. EST

This webinar will give participants an overview of the NASA CONNECT 
episode Breaking Barriers — Linear Equations. The accompanying 
education resource uses balloon-powered aircraft to generate data for 
analysis of linear equations in the context of breaking the sound barrier. 
This webinar addresses the Common Core State Standards for Math — 
Expressions and Equations. Register online to participate. https://www.
etouches.com/146817

For a full schedule of upcoming NASA Educator Professional Development 
webinars, visit http://www.txstate-epdc.net/events/.

Please direct questions about this series of webinars to Steve Culivan at 
stephen.p.culivan@nasa.gov.

2016 GLOBE Distinguished Educa-
tor Fellowship
The Global Learning and Observations 
to Benefit the Environment, or GLOBE, 
Program is accepting applications for the 
GLOBE Distinguished Educator Fellowship. 
This fellowship harnesses the GLOBE 
community expertise in the development of 
new educational resources that can benefit 
the whole community.

Selected educators, either formal or informal, 
will work with scientists in the development 
of GLOBE educational materials. The 
scientist will support the educator in 
ensuring scientific accuracy. As part of the 
application process, we invite teachers to 
team with scientists on a particular project.

There will be three fellowships awarded 
this year: one for the United States and 
two for GLOBE countries outside the U.S. 
Applicants must be active GLOBE teachers 
who have entered data into the GLOBE 
database in the past year.

All interested educators are invited to attend 
a webinar about the 2016 Distinguished 
Educator Fellowship on Nov. 12, 2015, at 
3 p.m. EST. 2015 Distinguished Educator 
Fellow John Moore and Dr. Julie Malmberg 
from the GLOBE Implementation Office 
Education and Outreach will lead the 
discussion. If you are unable to attend, 
the webinar will be recorded and made 
available for viewing after the webinar 
date. To register for the webinar, visit 
https://cc.readytalk.com/cc/s/
invite?id=2uur0y5aatyw.

Applications are due Dec. 15, 2015. 
Fellowships will begin no later than July 1, 
2016.

Additional information including 
application requirements can be found at 
http://www.globe.gov/news-events/globe-
events/competitions/fellowships.

Please email any questions about this 
opportunity to help@globe.gov.

https://www.etouches.com/144035
https://www.etouches.com/144035
https://www.etouches.com/137335
https://www.etouches.com/137335
https://www.etouches.com/146813
https://www.etouches.com/146817
https://www.etouches.com/146817
http://www.txstate-epdc.net/events/
mailto:stephen.p.culivan%40nasa.gov?subject=NASA%20Professional%20Development
https://cc.readytalk.com/cc/s/invite?id=2uur0y5aatyw
https://cc.readytalk.com/cc/s/invite?id=2uur0y5aatyw
http://www.globe.gov/news-events/globe-events/competitions/fellowships
http://www.globe.gov/news-events/globe-events/competitions/fellowships
mailto:help%40globe.gov?subject=2106%20Globe%20Distinguished%20Educator%20Fellowship


New Educational Materials: Engineering in the Classroom
Are you concerned about how engineering fits into your K-12 science curriculum? 
The education team at NASA’s Jet Propulsion Laboratory has created a set of videos 
and supporting text for educators to illustrate how real-world engineering at NASA 
can be applied to the Next Generation Science Standards.

The new instructor guide has a video for each grade span and NGSS “Engineering, 
Technology, and the Application of Science” performance expectation. Each video 
shows how JPL applies the standard, offers a lesson plan or activity, and makes 
suggestions for making the standard relevant.

Check out the guide at http://www.jpl.nasa.gov/edu/teach/resources/engineering-
in-the-classroom.php.

Looking for more? NASA’s Educational Resource Search Tool can help you find 
lesson plans, posters, educator guides and other materials to boost your science, 
technology, engineering and mathematics curriculum. Search hundreds of resources 
by subject, grade level, type and keywords.

To check out the search tool and begin your hunt for educational resources, visit 
http://www.nasa.gov/education/materials/.

Forgot to charge your electric car? – No problem!  
By Devin Hinkson

Electric charging lanes could be a reality on English roads within years. The U.K. 
is currently testing technology that charges electric vehicles while in transit. This is 
done by means of modern technology.  

Engineers have begun trials which will test the practicality and effectiveness of this 
new method. During the trials, vehicles will be fitted with wireless technology and 
special equipment will be installed beneath roads to replicate motorway conditions. 
Electric cables buried under the surface will generate electromagnetic fields, which 
will be picked up by a coil inside the device and converted into electricity.  

If cellphones can be charged on wireless stations, cars also could be. 

This isn’t the first trial of its kind. In South Korea, a 7.5-mile (12 km) stretch of road 
charges electric buses as they drive along, via a process called Shaped Magnetic 
Field in Resonance (SMFIR).  In England, a trial in Milton Keynes saw buses charged 
wirelessly through plates in the road, but they had to stop moving to receive the juice. 
This would be an even bigger breakthrough than the bus system in South Korea. 

Unless you happen to own a Tesla and live near a super charging station, the current 
battery life of electric cars doesn’t go incredibly far. While electric cars may get 260 
miles to a full charge, gas-guzzling cars can get 300 miles or more.

This innovation would be very useful to many people because they would not need 
to charge their vehicles at a charging station, but could receive power while driving, 
allowing them to commute more effectively, and encourage drivers to purchase 
and drive more electric vehicles. Electric vehicles have no emissions, and can have 
surprisingly powerful engines. 

Transport minister Andrew Jones says that “the government is already committing 
500 million pounds (763,457,500 US Dollars) over the next five years to keep Britain at 
the forefront of this technology.”

Debates continue as to whether or not this method is practical or effective, and 
whether batteries could be done away with completely if this technology becomes 
mainstream. 

http://www.jpl.nasa.gov/edu/teach/resources/engineering-in-the-classroom.php
http://www.jpl.nasa.gov/edu/teach/resources/engineering-in-the-classroom.php
http://www.nasa.gov/education/materials/


Five Microsoft Word Features Worth Knowing 
About
by Devin Hinkson

Imagine going on a cruise ship having packed a whole week’s 
worth of food for your trip, only to discover on the last day that 
the meals you thought you had to pay for, and therefore didn’t 
enjoy, were included in the price of your ticket. Wouldn’t you 
feel like you had missed out? 

Many of us don’t enjoy the ease and conveniences technology 
has to offer only because we are unaware of their existence! 

I want to highlight five functions of Microsoft Word which are 
useful but which few actually utilize. 

Password protecting documents. 

If you’ve got any top-secret documents floating around your 
Documents folder, you might want to secure those from 
prying eyes. Thankfully, Word has a feature that allows you 
to password protect your documents, whether it’s an expense 
report, an academic paper, or a personal diary entry. Just fire 
up Word, go to the Tools menu located to the left of the Save 
button, select General Options and then enable password 
encryption by selecting Password to Open box. Or, if you’re 
sharing a document and you only want certain people to have 
access to it, select the Password to Modify box so that they may 
be allowed to save their changes in the document.

Passwords in Word are case sensitive and there is no way to 
retrieve the password if you forget it, so make sure you keep 
track of which documents you do secure.

Virtual sticky notes  

Navigating through a lengthy document can be quite the 
endeavor, especially if you need to pinpoint an exact location 
to change one minor thing. But Word allows you to bookmark 
specific parts of your document so you can return them later—
think of it as the virtual sticky note.

To insert a placeholder, select the portion of your document 
you’d like to bookmark and point your cursor to the Ribbon, 
then click on the Insert Tab. Select Bookmark in the fourth 
column titled Links. A dialogue window will pop up asking 
you to type in a Bookmark name. Type in a name beginning 
with a letter and no spaces and then click Add.

Type slides directly into PowerPoint.

Whether you’re a new user or have been using Office since 
version 4.0, you know that using PowerPoint can be quite a 
task. If typing up your slides directly into PowerPoint seems 
like too much of a feat—because you’re rather spend your time 
working on transitions and inserting Clip Art—you can easily 
insert text from a Word document into its own PowerPoint 
presentation. On the Home tab, located in the Ribbon, point 
your cursor to the second column dubbed Slides. Click on the 
arrow under New Slides and select the second option at the 
bottom of the dialogue window, Slides from Outline.

A browser window will pop up, asking you to locate the file  
you would like to convert into a presentation. Once you select 
the file, it will run through PowerPoint and you’ll notice that 
each paragraph break will initiate a new slide. The trick is to 
type our your Word file as if it were a main point and then 
bullet points to follow, that way you keep your presentation 
cohesive. Also, keep in mind that pictures and font do not 
translate over to PowerPoint; you’ll have to customize your 
presentation to your liking.

Remove formatting

If text has been formatted and you change your mind about 
how it should appear, click the word in question, or select 
a section of text, and press [Ctrl]+[Space] simultaneously. 
If the formatting has been applied with a style, press 
[Ctrl]+[Shift]+[N] and it will then revert to the default style.

Hanging indent

One of the less frequently used means of formatting paragraphs 
is the hanging indent. This is where the first line is not 
indented, but all of the rest are.

Select the paragraph you’d like to format in this way, move 
to the Home tab and double-click the arrow icon in the lower 
right-hand corner of the ‘Paragraph’ pane.

On the Indents and Spacing tab, use the ‘Special’ dropdown 
menu in the middle of the dialog to select the ‘Hanging’ option 
and then indicate the indentation level. To apply the indent, 
click ‘OK’.



Secure Cyberspace 
By Dave Wilkins

Level One
TedEx Cyber Security: 
https://www.youtube.com/
watch?v=fSErHToV8IU 

TedEx Cyber Security: 
https://www.youtube.com/
watch?v=metkEeZvHTg 

• What can you do to keep 
yourself and information 
secure online?

• How can you educate 
others to do the same?

• Why is it important to be 
secure online?

• What devices do you use 
that can be hacked?

• How do viruses and 
malware gain access to 
your computer?

Level Two
How a VPN works: https://
www.youtube.com/
watch?v=zpUHD-PQuZg 

How a VPN works: https://
www.youtube.com/
watch?v=plvWpky92eU 

VPN - What is a VPN? A VPN 
(Virtual Private Network) 
is a method used to ensure 
privacy and security to private 
and public networks that you 
are connected to such as WiFi 
Hotspots and the Internet. 
VPNs are most often used by 
companies and corporations 
to protect sensitive data. 
However, using a personal 
VPN is increasingly becoming 
more popular.

Your online privacy is 
increased with a VPN because 
your initial IP address is 
replaced with one from 
the VPN provider. You can 
appear to be located nearly 
anywhere in the world with a 
VPN connection. This method 
allows you to attain an IP 
address from any gateway 
city the VPN service provides. 
For instance, you may live in 
Salt Lake City, but connecting 

with a VPN, you can appear 
to live in the United Kingdom, 
New York, or any number of 
gateway cities. 

Free VPN:

https://www.betternet.co/ 
http://justfreevpn.com/ 

Paid VPN:

http://vpnhq.com/HTPPS/
SSL

https://www.youtube.com/
watch?v=earzZpX-PiY 

SSL (Secure Sockets Layer) is 
a standard security protocol 
for establishing an encrypted 
link between a server and a 
client. It’s done most typically 
between a web server 
(website) and a an internet 
browser; or a mail server 
and a mail client (such as 
Outlook). 

SSL encryption allows 
sensitive information such as 
credit card numbers, social 
security numbers, and login 
credentials to be transmitted 
securely. Normally, data 
sent between browsers and 
web servers is sent in plain 
text—leaving you vulnerable 
to eavesdropping and this 
information being stolen. If 
an attacker is able to intercept 
all data being sent between 
a browser and a web server 
they can see and use that 
information. 

You can follow this link to 
check if the website you are on 
has an SSL:

https://www.sslshopper.
com/ssl-checker.
html?hostname 

Internet Abuse
Phishing scammers are getting 
very smart with their ability 
to disguise a fake website 
to appear real. For example, 
they will have a website 
such as this: http://paypal.
com-international.info – most 
people won’t recognize the 
issue here as it clearly says 

paypal.com. However, this is 
not Paypals real website. This 
is a sub domain of the domain 
com-international.info -- com-
international.info is the real 
domain name. They’ve created 
“paypal” as a sub domain so 
it appears to be real. Many 
fall victim to noticing this 
delusion and enter their bank 
account information to a fake 
website. 

http://whois.com/whois/   
is a legitimate website that 
displays the domain name 
owner’s details, registrar, 
and some DNS records. For 
example, here is the WHOIS 
details of Facebook:

http://www.whois.com/
whois/facebook.com 

Level Three
Think you understand cyber 
security well enough to do 
something about it here? Here 
are some activities you can do 
to make yourself secure and 
warn others of dangers online.

Set up your devices through a 
free or paid VPN. Free VPN:

https://www.betternet.co/

http://justfreevpn.com/

Search the internet for 
fraudulent websites 
(phishing), find the owner and 
registrar of the domain name, 
and report it. 

Verify that the websites you 
use most have an SSL:

https://www.sslshopper.
com/ssl-checker.
html?hostname

Other Links and Sources 
http://engineeringchallenges.
org/9042.aspx

https://en.wikipedia.org/
wiki/National_Strategy_to_
Secure_Cyberspace 

http://www.dhs.gov/
national-strategy-secure-
cyberspace 

https://www.youtube.com/watch?v=fSErHToV8IU
https://www.youtube.com/watch?v=fSErHToV8IU
https://www.youtube.com/watch?v=metkEeZvHTg
https://www.youtube.com/watch?v=metkEeZvHTg
https://www.youtube.com/watch?v=zpUHD-PQuZg
https://www.youtube.com/watch?v=zpUHD-PQuZg
https://www.youtube.com/watch?v=zpUHD-PQuZg
https://www.youtube.com/watch?v=plvWpky92eU
https://www.youtube.com/watch?v=plvWpky92eU
https://www.youtube.com/watch?v=plvWpky92eU
https://www.betternet.co/
http://justfreevpn.com/
http://vpnhq.com/HTPPS/SSL
http://vpnhq.com/HTPPS/SSL
https://www.youtube.com/watch?v=earzZpX-PiY 
https://www.youtube.com/watch?v=earzZpX-PiY 
https://www.sslshopper.com/ssl-checker.html?hostname
https://www.sslshopper.com/ssl-checker.html?hostname
https://www.sslshopper.com/ssl-checker.html?hostname
http://whois.com/whois/
http://www.whois.com/whois/facebook.com
http://www.whois.com/whois/facebook.com
https://www.betternet.co/
http://justfreevpn.com/
https://www.sslshopper.com/ssl-checker.html?hostname
https://www.sslshopper.com/ssl-checker.html?hostname
https://www.sslshopper.com/ssl-checker.html?hostname
http://engineeringchallenges.org/9042.aspx
http://engineeringchallenges.org/9042.aspx
https://en.wikipedia.org/wiki/National_Strategy_to_Secure_Cyberspace  
https://en.wikipedia.org/wiki/National_Strategy_to_Secure_Cyberspace  
https://en.wikipedia.org/wiki/National_Strategy_to_Secure_Cyberspace  
http://www.dhs.gov/national-strategy-secure-cyberspace
http://www.dhs.gov/national-strategy-secure-cyberspace
http://www.dhs.gov/national-strategy-secure-cyberspace


Free Google Apps E-Book
Chalkup has provided a free Google 
apps e-book for education. This 
e-book provides useful information 
about Google products and their 
application for educators. This 
e-book will help teach how to use 
each Google app more effectively 
and how to have all the apps work 
together seamlessly. 

For those who don’t want to pay for 
Microsoft Office, Google provides 
apps such as Google Docs, Google 
Sheets, and Google Slides, which 
are similar to Microsoft Word, Excel, 
and PowerPoint. All google apps 
can be accessed over the internet, so 
you can access your work with ease 
when moving from one computer to 
another.

To access this free e-book go to 
http://info.chalkup.co/google-apps-
for-education-free-resource and enter 
your name, email, and school.

New Features in iOS 9 
With the new release of iOS 9, there have been tons of new features added to iPhones 
an iPads. Here are some useful new features added in iOS 9.

Low Power Mode - Everyone hates when their phone dies. One of the most common 
sayings of this generation is probably “My phone just died.” With how often many 
of us use our phones, keeping the phone alive all day is a difficult task. Low power 
mode disables certain features, such as automatic downloads and mail fetch, in order 
to reduce battery drain. When the battery reaches 20%, and 10% prompts arise, you 
automatically switch to Low Power Mode. Otherwise, Low Power Mode can be 
found in Setting > Battery

Back Button - Not quite as universal as the Android back button, but it’s something. 
Now when moving from app to app there is a back button in the top left corner of the 
screen.

Siri Update - Siri now has more features similar to Google Now. It will now provide 
useful information and suggestions before being asked. For instance, if you go to the 
same park every day at about the same time, Siri will tell you how long it will take to 
get there once it notices you leaving.

New Notes App - The notes app has experienced a huge change with many new 
features added. You can now take picture, add text, draw, sketch, and more.

These are just a few of the many new features in iOS 9. The first few days and 
weeks of a new operating system update are full of new features. So far iOS has not 
disappointed.

You might want to watch this YouTube video:  iOS 9 Hidden Features - Top 50 List

A Better Way to Slide by Kelson English

Whether PowerPoint Presentation, Keynote, or something else, we have all had 
to make a slideshow. Whether teaching a class or presenting a business plan, 
slideshows have become the popular way of presenting information. Slidebean.
com provides an online slideshow making program that stands above the rest.

The website provides an easy and straightforward method to create a slideshow. 
The website itself is easy to navigate and the slideshow making materials are so 
simple the slideshow basically makes itself.

While looking into this 
website I found more and 
more features that make 
Slidebean stand above 
the rest. For example, 
depending on which layout 
you choose, Slidebean will 
make suggestions of what 
to put on each slide. This 
image of the second slide 
suggested I ask a question.

Slides created on Slidebean can either be used from the internet or downloaded 
in case there is no internet connection.

What really sets Slidebean above the rest is the simplicity to make a well-
formatted and organized slideshow in a fraction of the time.

http://home.slidebean.com

http://info.chalkup.co/google-apps-for-education-free-resource
http://info.chalkup.co/google-apps-for-education-free-resource
https://youtu.be/8iCiFYax_dk
http://home.slidebean.com


Zaption: More than Just Watching by Kelson English

https://www.zaption.com

Incorporating videos and other digital media into the 
classroom can be a useful and effective way of teaching. 
Zaption provides the ability to turn watching videos in class 
from a passive event to an interactive learning opportunity.

Zaption is a free program that allows the user to find videos 
and add in a variety of elements such as images and text. This 
will allow the teacher to add additional information next to the 
video while the video is playing. This can be used to show the 
audience specific information, important key facts, or related 
material. The video lessons can also pause the video and ask 
questions for the students to enter in before the video continues 
on.

This program also includes a continually growing gallery of 
video lessons. Video lessons come in all topics and for all age 
groups. Whether teaching mathematics to kindergarteners or 
history to a higher education class the Zaption Gallery will 
have it.

Since Zaption is free, students can use it as well. As a student, 
this program provides a more interactive opportunity for class 
projects and presentations. Students can share and view video 
lessons shared to them as well.

The power of Zaption is that is makes the viewer interact with 
the video being presented. This causes the viewer to be more 
attentive and focus on the material, rather than passively 
watching without retaining any information.  Click the 
YouTube video below...

Swiftkey Keyboard for Android
Swiftkey keyboard would be very helpful for all those who 
don’t have a swipe installed on their mobile device already. 

Description

SwiftKey Keyboard is a free, award-winning keyboard app 
for Android that learns from you, delivering the best next-
word prediction, smarter autocorrect, support for over 800 
emoji (emoticons), emoji prediction and much more!

SwiftKey is the alternative touch keyboard that gives you 
smart, fast typing on Android - free. It’s the best smart 
keyboard for Android for fast SMS, chat, text and email, 
becoming the default across all your apps. It’s packed 
full of customization features including over 70 colorful 
themes, layouts for all screen sizes and devices, and 
supports over 80 languages.

EMOJI AND EMOJI PREDICTION - Spoil yourself with 
over 800 emoji characters (emoticons) and useful Emoji 
Prediction. Our signature prediction tech suggests emoji to 
match your words - for fun-filled sentences and smiles all 
round.

TRUSTED BY MILLIONS - The best, top-rated keyboard 
on Android, now available for free. As CNN wrote, “the 
number one third-party keyboard ... SwiftKey is a must-
have.”

PERSONALIZED PREDICTIONS - Mind-reading word 
suggestions that learn from you as you type, and get 
smarter over time.

SMARTER AUTOCORRECT - Intelligent autocorrections 
for even the sloppiest typing.

BEAUTIFUL THEMES - Customize the look of your 
keyboard with free and premium themes from the 
SwiftKey Store, including Disney’s Frozen.

YOUR KEYBOARD, YOUR WAY - Split. Resize. Undock. 
Tweak your keyboard with a variety of powerful tools to fit 
your needs.

Multilingual typing. Choose from over 80 languages and 
type in up to three at once.

CLOUD-CONNECTED - Sync your writing style securely 
to the cloud and across devices.

Personalize word predictions from your Gmail, Facebook, 
Twitter, Evernote and more.

Type with ease about daily news, sports and entertainment 
topics with Trending Phrases.

Gain access to the SwiftKey Store to browse new themes.

EFFORTLESS TYPING - Swipe your finger across the touch 
screen to type with SwiftKey Flow or tap predictions for 
easy, fast typing.

Follow us on Facebook by searching for “SwiftKey” and on 
Twitter at @swiftkey.

https://www.zaption.com
https://youtu.be/_NYb5rI7CFA
https://youtu.be/_NYb5rI7CFA


Personal Holograms 
 
With the impending advent of the new Star Wars movies come 
the classic questions with it. These question range from, “Why 
haven’t we made light sabers yet? I want one!” to “Why can’t 
we make holograms after decades of work when Princess Leia 
can make one in a matter of seconds?” 

Despite how far away these fantasies seem, would it be cool to 
make your own hologram projector from scratch in a matter of 
minutes?

The science behind holograms seems very straightforward. We 
can put light onto a screen and watch it, so why not project it 
three dimensionally? The problem arises in the fact that light 
will travel along it’s course forever until it hits something. This 
makes three dimensions really difficult because it involves light 
stopping at finite distances to give it a sense of depth.

In more realistic science fiction media like the TV show 
seaQuest, ideas have been bounced around like projecting the 
light into a thin film of smoke. But has it been simpler than this 
all along?

As simple as this two minute YouTube video shows, you can 
take a CD case and turn a phone or tablet into a hologram 
projector! All it really does is makes a pyramid type shape out 
of transparent material. This way, when light hits the material 
it is then reflected outwards to give the impression that the 
image is actually above the screen. Because the pyramid had 
four sides, there are four different surfaces in which the light 
is projected onto, and the three dimensional hologram can be 
seen!

The only draw back to this current system is a specific video 
needs to be made with four angles of the object to give it the 
proper appearance. This also has been done before, and there 
are videos of various objects, or a screensaver style ball of light 
flying around the space above the screen.

These videos still take work to make, but some cool slightly 
different concepts have been presented. In this video, an Iron 
Man action figure is placed in the space inside the hologram 
projector and overlaid with different suits. This particular 
video was custom made, and had to be exact in the dimensions 
so that the action figure did not poke through the hologram. 

This concept definitely has its limitations, but how easy is it 
to make and show to others? It makes one stop and wonder 
how far in the future this technology really is. If we don’t pay 
attention, holograms and other technologies like this will creep 
up on us and become part of our daily lives before we even 
realize we are living in a science fiction reality!

YouTube Video: Turn your Smartphone into a 3D Hologram

https://youtu.be/7YWTtCsvgvg

https://www.youtube.com/watch?v=Wsg8KDKVNGE
https://www.youtube.com/watch?v=9ptFx_fj7kg&list=PLAuYLA_2gCR-xv8oYlmoIIQmxRTKA0CGT&index=2
https://www.youtube.com/watch?v=CZhjEQuR_fo
https://www.youtube.com/watch?v=CZhjEQuR_fo
https://youtu.be/7YWTtCsvgvg



